## Contents

### DOCUMENT CHANGE HISTORY

3

### D2L ePORTFOLIO BASICS

D2L ePortfolio user interface overview ................................................................. 4
D2L ePortfolio settings ......................................................................................... 7
Enable notifications in D2L ePortfolio ................................................................. 8
What are activity icons? ..................................................................................... 9

### D2L ePORTFOLIO ARTIFACTS

Add a reflection .................................................................................................. 9
Add a linked web address .................................................................................. 9
Upload files ....................................................................................................... 10
Add a web document ......................................................................................... 10
Add an audio recording ..................................................................................... 10
Add a form response ........................................................................................ 11
Add course results ............................................................................................ 11
Associate artifacts with a reflection ................................................................. 11
Associate artifacts with learning objectives .................................................. 12

### D2L ePORTFOLIO PRESENTATIONS

Add a new presentation ...................................................................................... 12
About copying presentations ........................................................................... 13
Edit a presentation layout ................................................................................. 13

### D2L ePORTFOLIO COLLECTIONS

Create a new collection ....................................................................................... 14
Add items to a collection using a tag list ......................................................... 14

### D2L ePORTFOLIO ITEM ASSESSMENT

About assessment settings .................................................................................. 15
About editing and commenting on D2L ePortfolio items .............................. 15
Submit D2L ePortfolio items to a dropbox folder .......................................... 15

### SHARING ITEMS IN D2L ePORTFOLIO

About sharing groups .......................................................................................... 16
Create a sharing group ....................................................................................... 16
Sharing permissions ......................................................................................... 17
Understanding cascading permissions ................................................................. 18
About sharing D2L ePortfolio items ..................................................................... 18
About viewing shared items .................................................................................. 20
Share D2L ePortfolio items with internal users .................................................. 21
Send an invitation to a user .................................................................................. 21
Share a presentation with all external users ....................................................... 21
Share a presentation with specific external users ................................................. 22
Ignore shared items .............................................................................................. 22
Restore ignored shared items ................................................................................ 22
Remove sharing permissions from an item ......................................................... 22
Remove sharing permissions from a sharing group ............................................. 23
About creating quicklinks to D2L ePortfolio items ........................................... 23
IMPORTING AND EXPORTING D2L EPORTFOLIO ITEMS .................................... 23
Import D2L ePortfolio items .................................................................................. 23
Export items in your D2L ePortfolio .................................................................... 24
About exporting D2L ePortfolio items ................................................................. 24
What property changes occur when I export D2L ePortfolio items? .................. 25
Export a presentation in HTML format .............................................................. 26
What property changes occur when I export a presentation to HTML format? .... 27
ABOUT D2L ........................................................................................................... 29
Document Change History

This version of the document replaces all previous versions. The following table describes the most recent changes to this document.

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Summary of Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>August 5, 2015</td>
<td>Initial Release</td>
</tr>
</tbody>
</table>

The content in this guide is applicable to the most recent version of D2L ePortfolio unless otherwise noted.
D2L ePortfolio basics

D2L ePortfolio user interface overview

D2L ePortfolio is divided into 4 main pages: the Dashboard, the My Items page, the Explore page, and the Sharing Groups page.

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D2L ePortfolio Dashboard</td>
<td>The Dashboard is the main landing page for D2L ePortfolio. On the Dashboard page, you can add new content to your D2L ePortfolio, review recent activity on your items and items shared with you, and check invites from your peers. The &quot;What are you learning?&quot; panel prompts you to record brief thoughts about a current learning experience which you can expand upon at a later date. You can also add file artifacts or a link artifact to your D2L ePortfolio or associate them with your brief reflection. When you post an item, it automatically shares with the default sharing group you specify in your D2L ePortfolio settings.</td>
</tr>
<tr>
<td>Page</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>The newsfeed consolidates recent activity on your items and items shared with you. Your items appear in this area if they have been recently edited, commented on, or assessed. If you contribute a comment, an edit, or an assessment to another user’s item, that item also appears in the newsfeed and you can see contributions others are making to it. Filters at the top of the newsfeed enable you to search and view specific sets of content: recent activity by ownership, people and items you've subscribed to, and items from contacts in the Pager tool via the Friends List.</td>
</tr>
<tr>
<td></td>
<td>The Unread Invites panel displays your recent invites, including the author of the invite, the message content, and the associated D2L ePortfolio item.</td>
</tr>
<tr>
<td>Page</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| My Items          | The My Items page consolidates all of your artifacts, reflections, presentations, collections, and learning objectives into a single view, enabling you to view, search, and manage all of your content from one location. On the My Items page you can:  
  • Add D2L ePortfolio content using the New Presentation, New Collection, and Add buttons.  
  • Bulk add items to a presentation or collection or bulk associate items with learning objectives using the More Actions button.  
  • Perform common actions on your D2L ePortfolio items, such as view, preview (image and HTML file artifacts only), edit, copy (presentations only), delete, and share.  
Your D2L ePortfolio items display in a list that you can sort and filter. |
| Explore           | The Explore page consolidates items others have shared publicly or privately with you into one view. Shared D2L ePortfolio items display in a list that you can sort and filter. On the Explore page you can:  
  • Browse items.  
  • Depending on your sharing permissions, view and leave comments and assessments and edit others' items. A feedback activity icon appears beside items when there is comment and assessment activity.  
  • Click on a user's name to view all content shared from that user.  
  • Subscribe to an item or a user.  
  • Use the search field to find content. The search checks for matches within item titles, tags, descriptions, and owner names. |
| Sharing Groups    | The Sharing Groups page displays all sharing groups to which you are a member. Use a sharing group to apply and save permissions for different users and groups of users. This allows you to attach the sharing group to new and existing items rather than specifying permissions for each item you create. |
# D2L ePortfolio settings

Settings allow you to change display options and preferences for your D2L ePortfolio.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Options</strong></td>
<td></td>
</tr>
<tr>
<td>Default list size</td>
<td>Select the number of items to display in your newsfeed, My Items, and Explore lists.</td>
</tr>
<tr>
<td>Number of activities on newsfeed items</td>
<td>Select the maximum number of events you want to display for each newsfeed item.</td>
</tr>
<tr>
<td>My Modifications</td>
<td>Select whether to include activity you make on your own items in your newsfeed.</td>
</tr>
<tr>
<td>Number of unread invites on dashboard</td>
<td>Select how many unread invites appear on your dashboard.</td>
</tr>
<tr>
<td><strong>Item Defaults</strong></td>
<td></td>
</tr>
<tr>
<td>Item feedback</td>
<td>Select whether you want to allow comments or assessments by default when creating items. Note: These settings enable commenting and assessments; you still need to set permissions around who can add comments or assessments.</td>
</tr>
<tr>
<td>Default presentation theme</td>
<td>This area displays the current default theme for the organization. If you have permission, you can click the Manage Themes link to make edits to presentation themes and their styles. Your edits will be visible to all other users in your organization.</td>
</tr>
<tr>
<td><strong>RSS Updates</strong></td>
<td></td>
</tr>
<tr>
<td>Feedback RSS</td>
<td>Notifies you when edits, comments, or assessments are made on one of your portfolio items by another user. To use RSS feeds, you must subscribe to an external RSS reader.</td>
</tr>
<tr>
<td><strong>Ignore List</strong></td>
<td></td>
</tr>
<tr>
<td>Ask for confirmation before ignoring items from users</td>
<td>Select if you want to see a confirmation dialog asking if you want to ignore items from a user.</td>
</tr>
<tr>
<td>Ask for confirmation before restoring items from users</td>
<td>Select if you want to see a confirmation dialog asking if you want to restore items from a user.</td>
</tr>
</tbody>
</table>
Enable notifications in D2L ePortfolio

You can sign up to receive immediate text or email notifications when D2L ePortfolio feedback gets added to subscribed items or to your items, and when another user has subscribed to your items.

You must set up a contact method before subscribing to notifications.

1. On the minibar, from your personal menu, click **Notifications**.

2. In the **Instant Notifications** area, select how you want to receive notifications for any of the following options:
   - D2L ePortfolio - feedback added to subscribed items
   - D2L ePortfolio - another user has subscribed to your updates
   - D2L ePortfolio - feedback added to my items

3. Click **Save**.
What are activity icons?

Once you share items with others and they provide comments or rubric assessments, on the My Items page, icons that represent this activity appear beside your items.

You can click on these icons to view details about which individuals or groups you are sharing an item with or to review comments and rubric assessments made on that item.

Clicking on the sharing group icon or individual icon opens an item's Sharing Settings dialog. From here you can modify who can access your item. Clicking on the feedback icon opens an item's View page where you can review comments and rubric assessments from others.

An image artifact with activity icons

D2L ePortfolio artifacts

Add a reflection

Use reflections to discuss items in your D2L ePortfolio, record your thoughts on topics that interest you, set goals, and think critically about your learning.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the Add button, click Reflections.
3. Enter your reflection details.
4. Click Save and Close.

Add a linked web address

If you want to include an existing website as an artifact in your D2L ePortfolio, you can reference the site's URL rather than uploading files.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the Add button, click Link.
3. Enter your link details.
4. Click **Save**.

### Upload files

Upload files from your computer, personal storage device, D2L Learning Environment locker area, or Google Drive that demonstrate your improvement or mastery in an area of interest.

1. On the navbar, click **ePortfolio**.
2. On the **My Items** page, from the **Add** button, click **File Upload**.
3. Click **Upload**, then locate your file.
4. Click **Add > Next**.
5. Enter your file details.
6. Click **Save**.

### Add a web document

D2L ePortfolio provides the option to create HTML artifacts using a simple HTML Editor. HTML files may contain formatted text, images, videos, audio files, and links to content in D2L Learning Environment.

1. On the navbar, click **ePortfolio**.
2. On the **My Items** page, from the **Add** button, click **Web Document**.
3. Enter your web document's file name.
4. In the **Content** field, add your HTML content.
5. Click **Next**.
6. Enter your web document details.
7. Click **Save**.

### Add an audio recording

You can record audio directly within D2L ePortfolio, rather than pre-recording audio on your computer and uploading it as a file.

1. On the navbar, click **ePortfolio**.
2. On the **My Items** page, from the **Add** button, click **Audio Recording**.
3. Click **Record**. Record your message.
4. Click **Next**.
5. Enter your audio recording details.
6. Click **Save**.
Add a form response
Forms templates, created by your institution or course leaders, collect information using a set of question fields that you fill out.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the Add button, click Form Response.
3. Click the form template for which you want to add a response.
4. Enter your responses.
5. Click Save.

Add course results
Track your progress over time by including your course work in your D2L ePortfolio. You can then review your work at any point in the future and compare it to other assignments and courses.

If you import quiz or dropbox folder results into your D2L ePortfolio, any learning objectives associated with the quiz or dropbox folder also import.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the Add button, click Course Results.
3. Click on the course containing the results you want to add.
4. Select the check box for every result you want to add. Click Next.
5. Enter your result details.
6. Click Save.

Associate artifacts with a reflection
You can associate reflections with artifacts, learning objectives, collections, or presentations in your D2L ePortfolio. Associating reflections with other items helps other users see the relationship between the items and makes it easier to revisit your goals and assumptions later.

Reflections are only visible to other users if you share them, associate them with an item, or add them to a collection or presentation.

When you share a reflection that is associated with an item, users can only view the name of the associated item unless that item is also shared with them.

Sharing an item associated with a reflection allows users to view the reflection as part of the item.

If you include a reflection in a collection or presentation, it inherits the permissions of that collection or presentation.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the reflection you want to add an association to, click Edit.
3. In the **Associated Items** area, click **Add**.

4. In the **Associate Items** dialog, select whether you want to associate the reflection with an artifact, collection, presentation, or learning objective.

5. Select the check box for any item you want to associate with the reflection. Click **Add**.

6. Click **Save and Close**.

**Associate artifacts with learning objectives**

Learning objectives enable you to take ownership of your learning through the management and tracking of personal learning goals.

Associate learning objectives with artifacts, reflections, collections, and presentations that demonstrate progress toward your learning plan. If you submit a learning objective to a dropbox folder, its associated items go with it.

Items associated with a learning objective are not available to others unless you specifically share them.

1. On the navbar, click ![ePortfolio](image).

2. Do one of the following:
   - On the **My Items** page, from the context menu of an artifact, click ![Associate Learning Objective](image).
   - On the **My Items** page, select the check box of any item you want to associate with a learning objective. Then, from the **More Actions** button, click ![Associate Learning Objective](image).

3. In the **Associate Learning Objectives** dialog, click the objective you want to associate. Click **Associate**.

**D2L ePortfolio presentations**

**Add a new presentation**

Presentations let you compile D2L ePortfolio items into a web project to showcase your achievements. Your presentations can have multiple pages. Presentations provide a polished, professional medium to demonstrate your learning and accomplishments.

A banner appears at the top of every page in a presentation. The presentation title usually appears in the banner, much like a header in a book. You can include additional text in the banner as a description. The theme of the presentation controls the style of the banner, including the background and fonts used.

Themes are default style templates that give your presentations a consistent look and feel. Themes are comprised of styles which control one aspect of the design. For example, there are separate styles that control the look of titles, links, dates, and images.

Your organization provides presentation themes, but you may be able to change some or all aspects of a theme.

1. On the navbar, click ![ePortfolio](image).

2. On the **My Items** page, click ![New Presentation](image).
3. In the **Properties** tab, enter your presentation details. Click **Save**.

4. In the **Content/Layout** tab, do any of the following:
   - To add pages to your presentation, in the **Pages** panel, click the **New page** icon. Enter your page details. Click **Save**.
   - To add content to your presentation, in a **Content Area** panel, click **Add Component**. Locate your component, select it, and click **Add**.

5. In the **Banner** tab, enter your banner details.

6. In the **Theme** tab, do any of the following:
   - To edit your current theme, in the **Current Theme** area, click the **Edit Styles** icon. Make your changes. Click **Save**.
   - To select a new theme for your presentation, in the **Available Themes** area, click **Select > Set Theme**.

**About copying presentations**

You can copy presentations only from your own D2L ePortfolio. When copying a presentation, the following information copies:

- The presentation’s description, tags, comments, and assessment properties
- The theme
- The banner title, description, and appearance
- All pages, page layouts, page content, display options, and display orders

The following information does not copy:

- Permissions
- Comments or assessments for the presentation
- Reflections associated with the presentation

**Edit a presentation layout**

1. On the navbar, click **ePortfolio**.

2. On the **My Items** page, from the context menu of the presentation you want to edit, click **Edit**.

3. In the **Content/Layout** tab, do any of the following:
   - To edit where the page navigation appears, click **Edit Presentation Navigation**. Select your navigation option. Click **Save**.
   - To edit where content areas appear on a page, click **Edit Page Layout**. Select your layout option. Click **Save**.
   - To move an item in a content area, from the item’s context menu, click **Move [Up/Down/To]**.
   - To remove an item in a content area, from the item’s context menu, click **Remove from Layout**.
**D2L ePortfolio collections**

Create a new collection

Collections are groups of artifacts, reflections, presentations, and learning objectives. An item can belong to multiple collections at the same time. For example, you can add a short story you wrote to a collection called “Fiction” as well as a collection called “Creative Writing 101” and there will only be one copy of the story (artifact).

1. On the navbar, click ePortfolio.
2. On the My Items page, click New Collection.
3. Enter your collection details.
4. Click Save.
5. In the Items in Collection area, click Add to Collection.
6. Click Artifacts, Presentations, Reflections, or Learning Objectives.
7. Select the check box for every item you want to add. Click Add.
8. Click Save and Close.

Add items to a collection using a tag list

All items that use the tags that you specify in the tag list are automatically added to the collection. If you share the collection with other users, you automatically share all of the items.

In order to add an item to your collection using a tag list, the item must contain all of the tags identified in the list. For example, if you create a tag list with the tags science, astronomy, and Venus, you must tag the item with all three words in order for it to automatically add to the collection upon creation. If you want the item to only require one of the tags, create three separate tag lists each containing one of the tag words.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the collection you want to add items to using a tag list, click Edit.
3. In the Items in Collection area, click Add to Collection > Tag List.
4. Enter a name for your list. In the Tags in List field, enter the tags for your list.
5. Click Save.
D2L ePortfolio item assessment

About assessment settings

Enabling comments on an artifact, collection, reflection, presentation, or learning objective allows users who are viewing the item to leave feedback. Use this feature to collaborate with peers so they may comment on your work, provide constructive criticism, or point out additional resources.

Enabling assessments for an artifact, collection, reflection, presentation, or learning objective allows users with the appropriate permissions to evaluate the item using a rubric. You must select which rubric you want used when you are being evaluated from the list provided by your organization.

When others comment on and assess an item in your D2L ePortfolio, their feedback becomes a part of the item. You can see it below the item's details when viewing the item or through the feeds and widgets on your dashboard.

You can enable comments and assessments for all items by default or enable them individually on an item by item basis.

About editing and commenting on D2L ePortfolio items

In order to leave comments, assessments, or annotations on an item in a user’s D2L ePortfolio, you must have the appropriate permissions. You can receive permissions to comment on, assess, or edit a user’s work in one of two ways:

- The user gives you the appropriate permissions
- You set up a forced sharing group for users in a particular course that gives you the appropriate permissions

Encouraging users to give you permission to comment on and assess portfolio items that relate to course work is an excellent way to provide users with informal, intermittent feedback.

Submit D2L ePortfolio items to a dropbox folder

You can submit your D2L ePortfolio items to a dropbox folder in D2L Learning Environment for formal assessment. When you submit an item to a course dropbox folder, a copy of the item goes to the Dropbox tool. Future changes to the item in D2L ePortfolio do not transfer to the Dropbox copy.

If you submit a reflection or artifact to a dropbox folder, Quicklinks to associated items will also be included in the submission. For instance, a submitted artifact will include links to associated reflections. A submitted reflection will include Quicklinks to artifacts it is associated with.

If your item has comments and assessments on it but you don’t want to include them with your Dropbox submission, you must edit your item so that the Allow others to add/view comments if they have sufficient permission and Allow others to add/view assessments if they have sufficient permission check boxes are clear before you submit. This does not remove previous comments and assessments from the item itself. After you make your submission, you can select the check boxes to re-enable comments and assessments.

1. On the navbar, click Dropbox.
2. Click the folder you want to make a submission to.
3. In the Submit Files area, click Add a File.
4. From the tool panel, click ePortfolio.

5. Select the toggle for the item you want to add. Click Select Item.

6. Click Submit > Done.

Sharing items in D2L ePortfolio

About sharing groups

Sharing groups let you save the permissions you want a user or group of users to have so you can reuse the permissions for other items. You can create sharing groups for individual users or for all users in a particular course or group. You can have multiple sharing groups for the same users that you apply in different situations. For example, you can create sharing groups named Comment, and Edit and Review, and share them with the same group of peers. You would use the first sharing group for items you want to collect general feedback on, and the second sharing group for items that you want others to collaborate on or revise in detail.

An organization, department, or course can also set up sharing groups and share them with you. Sharing groups that are shared with you are either optional (you can choose to apply them to specific items) or automatic (you have to use them). Automatically shared groups are either visible (appearing in your Sharing Groups area) or hidden (information on the group is not available to you).

Create a sharing group

1. On the navbar, click D2L ePortfolio.

2. From the tool navigation, click Sharing Groups > New Sharing Group.

3. Enter your sharing group details.

4. Click Add Users.

5. Do one of the following:
   - To add individual users to the sharing group, in the Users tab, click on the users you want to add.
   - To add course offerings to the sharing group, in the Courses tab, click on the course offerings you want to add.

6. In the Assign Permissions area, select the permissions you want the sharing group to have.

7. Click Add > Save and Close.
Sharing permissions

In order to use the comments and assessments permissions, you must make sure the comments and assessments check boxes are enabled for the item and that a rubric for assessing items has been attached to the item. These check boxes are selected by default, but it is possible to clear them (if you want to temporarily remove the ability to comment on or assess an item), and you can change the default setting so they are not selected on new items.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
<th>Available For</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Allows selected users to see your D2L ePortfolio item on the Explore page</td>
<td>• Anyone</td>
</tr>
<tr>
<td>See comments from others</td>
<td>Allows selected users to see the comments other users have left on your D2L ePortfolio item</td>
<td>• Internal users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• External user with personal invite</td>
</tr>
<tr>
<td>Add comments</td>
<td>Allows selected users to add comments on your D2L ePortfolio item</td>
<td>• Internal users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• External user with personal invite</td>
</tr>
<tr>
<td>See assessments from others</td>
<td>Allows selected users to see rubric assessments other users have left on your D2L ePortfolio item</td>
<td>• Internal users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• External user with personal invite</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Not available for reflections</td>
</tr>
<tr>
<td>Add assessments</td>
<td>Allows selected users to evaluate your D2L ePortfolio item using a rubric, provided you have added a rubric to the item</td>
<td>• Internal users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• External user with personal invite</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Not available for reflections</td>
</tr>
<tr>
<td>Edit</td>
<td>Allows selected users to make changes to your D2L ePortfolio item, which you can track using the item’s Change Log.</td>
<td>• Internal users</td>
</tr>
</tbody>
</table>
Understanding cascading permissions

<table>
<thead>
<tr>
<th>Permissions situation</th>
<th>Description</th>
</tr>
</thead>
</table>
| Items in collections and presentations | When you include an item in a collection or presentation, the item inherits permissions from the collection or presentation (permissions are cascading), with the following exceptions:  
  - The **Add Assessments** permission is not inherited because it requires that a rubric be associated with each item.  
  - The **Edit** permission is not inherited because it would allow users to make major, possibly unwanted, changes to your D2L ePortfolio. If you want individuals to be able to edit items in a collection or presentation, you must give them the **Edit** permission on each item individually. |

Inherited permissions do not override existing permissions on items. For example, if you give an individual permission to view, see comments from others, and add comments for a specific item, but the collection only has the view permission set, the individual is able to see and add comments to the item. This is the case regardless of whether it is accessed from within or outside the collection.

| Items associated with a reflection | When you associate a reflection with another item, the reflection does not inherit permissions from the item, nor does the item inherit permissions from the reflection.  
Sharing a reflection associated with an item only allows users to view the name of the associated item. However, sharing an item associated with a reflection allows users to view the reflection as part of the item. |

About sharing D2L ePortfolio items

You can share your D2L ePortfolio items internally and externally.

Use permissions to share D2L ePortfolio items internally with other users. You can set up separate permissions options for each artifact, collection, reflection, presentation, and learning objective in your D2L ePortfolio so you can pick and choose what content you share with others. You can send invitations to internal users when you share an item with them. Sending an invitation gives you the opportunity to leave them a message about why you are sharing the item and what you’d like them to do with it. If you send an invite to a sharing group that includes all users at your organization or all users in a particular course or department, all of the users in the group will receive the invite.

You can also share D2L ePortfolio presentations externally with friends, parents, or potential employers in the following two ways:

- You can make the presentation publicly available to anyone through a URL. When you share a presentation this way people can only view the presentation. They cannot add comments, add assessments, or make edits to the presentation.
• You can send a personal invite to view your presentation via an email and the recipient can follow the attached link to view the presentation. The recipient must set up a username and password, and then they can see and add comments or assessments based on the permissions you gave them. External users cannot edit presentations.
About viewing shared items

There are various ways for you to discover, categorize, follow, and review content shared with you in D2L ePortfolio.

<table>
<thead>
<tr>
<th>Sharing Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invites</td>
<td>Invites enable you to promote the content you're sharing with specific people. An invite contains information about who shared the item, when it was shared, what type of item it is, and any description or tags it has. The sender might also include a message letting you know why they shared the item. When you receive an invite from another user to view an item in their D2L ePortfolio, a notification appears on the minibar and the invite displays on your D2L ePortfolio dashboard in the Unread Invites area. In addition, you might receive an email informing you of the invite. You can also subscribe to the Invite RSS feed in your D2L ePortfolio settings to receive external updates about new invites.</td>
</tr>
<tr>
<td>Subscriptions</td>
<td>Subscriptions enable you to follow activity on items or from specific people that interest you. You can subscribe to user or item activity from your dashboard, the Explore page, or your invites. Use the Subscriptions filter on your dashboard to view activity on items or from users you subscribed to. Recent subscription activity also appears in your minibar alerts.</td>
</tr>
<tr>
<td>Friends List</td>
<td>Use the Friends List filter on the dashboard to view content shared with you or publicly from friends in your pager list.</td>
</tr>
</tbody>
</table>
| Minibar alerts | Alerts on the minibar signal new activity related to your subscriptions and invites.  
- Message alerts display recently received invites.  
- Update alerts display assessments made on items or by people you've subscribed to.  
- Subscription alerts display comments made on items or by people you've subscribed to. |
| Email and SMS notifications | If you want to receive D2L ePortfolio updates externally, enable email or SMS notifications, which you can receive for the following situations:  
- An item you are subscribed to has feedback added to it  
- Another user subscribes to your updates  
- An item you created has feedback added to it |
Share D2L ePortfolio items with internal users

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the item you want to share, click Share.
3. Click Add Users and Groups.
4. Do one of the following:
   - To share with individual users, in the Users tab, click on the users you want to add.
   - To share with all users in a course offering, in the Courses tab, click on the courses you want to add.
5. In the Assign Permissions area, select the permissions you want the users to have.
6. Click Share > Close.

Send an invitation to a user

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the item you want to share, click Share.
3. In the Sharing List area, select the check box for every user you want to send an invitation to. If you do not see the user you want to invite in the list, click Add Users and Groups and add the user to the list.
4. Click Send Invite.
5. Enter your invitation details.
6. Click Send > Close.

Share a presentation with all external users

If you make a presentation public via URL, the system includes social media icons (Twitter, Google+, and Facebook) at the top of your presentation to enable further sharing.

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the item you want to share, click Share.
3. Select the Allow public viewing of presentation check box.
4. Share the provided URL with external users.
5. Click Close.
Share a presentation with specific external users

When you add an external user to your presentation using their email address, they will receive an email with a link inviting them to set up a username and password to view the presentation. The invite expires after three days (or another amount of time set by your organization).

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the item you want to share, click Share.
3. Click Add Users and Groups.
4. In the Add External User by Email Address area, enter the email address for the user you want to add. Click Add.
5. In the Assign Permissions area, select the permissions you want the users to have.
6. Click Share > Close.

Ignore shared items

If you have the appropriate permissions, you can ignore shared items from other users. Once you ignore a user, all items (including items you are subscribed to) and invites belonging to them are hidden from your newsfeed, the Unread Invites area, the Invites page, and the Explore page.

1. On the navbar, click ePortfolio.
2. Locate an item belonging to the user you want to ignore.
3. From the context menu of the item, click Ignore Items from User.
4. Click Ignore.

Restore ignored shared items

1. On the navbar, click ePortfolio.
2. Click Settings.
3. In the Ignore List area, beside the user whose items you want to restore, click the Restore Items icon.
4. Click Restore > Save and Close.

Remove sharing permissions from an item

1. On the navbar, click ePortfolio.
2. On the My Items page, from the context menu of the item from which you want to remove permissions, click Share.
3. In the Sharing List area, do one of the following:
   • To remove a user or course offering from the item, click the Remove Permissions.
To modify a user’s permissions for the item, click the **Edit Permissions** icon. Select or clear permissions for the user.

4. Click **Close**.

### Remove sharing permissions from a sharing group

You cannot modify sharing groups that your course or organization shares with you.

1. On the navbar, click **ePortfolio**.
2. On the **Sharing Groups** page, click on the sharing group for which you want to remove permissions.
3. In the **Sharing Group Members** area, do one of the following:
   - To remove a user or course offering from the sharing group, click the **Remove Permissions** icon.
   - To modify a user’s permissions in the sharing group, click the **Edit Permissions** icon. Select or clear permissions for the user.
4. Click **Save and Close**.

### About creating quicklinks to D2L ePortfolio items

You can create quicklinks to D2L ePortfolio content in the same way as other quicklinks. However, the person following the link must have that item shared with them.

If you include a quicklink to a D2L ePortfolio item in a form, reflection, artifact, or presentation, the referenced item does not inherit permissions from the item containing the link. This means that individuals viewing an item via the quicklink must also have direct permission to view the referenced item and follow the link; otherwise, they receive an error message letting them know they do not have permission to view the item.

### Importing and exporting D2L ePortfolio items

#### Import D2L ePortfolio items

You can only import D2L ePortfolio packages into your D2L ePortfolio. If you have other items you want to add to your D2L ePortfolio, you must add them individually.

1. On the navbar, click **ePortfolio**.
2. On the **My Items** page, from the **More Actions** button, click **Go to Import / Export page**.
3. Click **Import**.
4. Click **Browse**. Locate the package you want to import. Click **Open**.
5. Click **Next > Import**.
Export items in your D2L ePortfolio

1. On the navbar, click ePortfolio.

2. On the My Items page, from the More Actions button, click Go to Import / Export page.

3. Do one of the following:
   - To export all items, click Export > All Items.
   - To export specific items, click Export > Selected Items. Click Add Items, then select the items you want to export. Click Add.

4. Click Export.

5. Click the View progress of the export package link.

6. In the Download File dialog that displays, click the link for your exported package.

7. Save the file to your desktop.

About exporting D2L ePortfolio items

When you export an item, you also export the item’s description, tags, and settings. You do not export information about the user who created the item, users who left comments on the item, or assessments for the item.

With the exception of HTML presentations, you cannot export items for offline viewing. Exported items can only be imported into another D2L ePortfolio or systems that support the D2L ePortfolio XML format.

You can export your entire D2L ePortfolio or specific items. If an item has multiple associations, it will only appear once in the exported zip file.
What property changes occur when I export D2L ePortfolio items?

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Log for presentations</td>
<td>• Does not include</td>
</tr>
<tr>
<td>Assessments</td>
<td>• Does not include</td>
</tr>
<tr>
<td>Change Log for Edit permission</td>
<td>• Does not include</td>
</tr>
<tr>
<td>Comments</td>
<td>• Includes comments; does not retain commenter’s name</td>
</tr>
<tr>
<td>Contents of a collection</td>
<td>• Includes items within a collection only if you export the items at the same time</td>
</tr>
<tr>
<td>Forms</td>
<td>• Includes form artifacts; does not include the form that the artifact is based on</td>
</tr>
<tr>
<td></td>
<td>• System fields do not maintain their values; the system generates these values based on the user that imports the form</td>
</tr>
<tr>
<td></td>
<td>• Does not maintain rubrics embedded in a form</td>
</tr>
<tr>
<td>Items associated with a reflection</td>
<td>• Includes associated items only if you export the items at the same time</td>
</tr>
<tr>
<td>Items in a presentation</td>
<td>• Includes items within a presentation only if you export the items at the same time</td>
</tr>
<tr>
<td>Permissions</td>
<td>• See [item] only</td>
</tr>
<tr>
<td>Presentation layout</td>
<td>• Navigation settings, page settings, page names, and text areas remain the same</td>
</tr>
<tr>
<td></td>
<td>• Maintains profile settings, but displays information corresponding to the user who imports the presentation</td>
</tr>
<tr>
<td>Presentation theme</td>
<td>• Does not include presentation theme; presentations revert to the default system theme on import</td>
</tr>
<tr>
<td>Reflections associated with an artifact</td>
<td>• Includes associated reflections only if you export the reflections at the same time</td>
</tr>
<tr>
<td>Rubrics associated with an item</td>
<td>• Does not include</td>
</tr>
</tbody>
</table>
### Export a presentation in HTML format

If you have the appropriate permissions, you can export presentations to HTML format directly from a presentation's context menu.

Exporting your presentation to HTML format enables you to keep a copy of your presentation in a viewable format external to the system. This is useful if you change institutions and you don’t want to lose your work. Once you export your presentation to HTML, you can host it externally on your own website or save it on your computer to view offline.

You cannot import an HTML presentation back into D2L ePortfolio.

1. On the navbar, click 📚 ePortfolio.
2. On the My Items page, from the context menu of the presentation you want to export, click 📦 Export.
3. Select Export HTML version of presentation. To include links to pages within the system, select the All system links check box. Links to pages within the system require users to log in to the system and have the appropriate permissions.
4. Click Next.
5. In the Download File dialog that displays, click the link for your exported package.
6. Save the file to your desktop.

### Property Notes

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag lists for a collection (dynamic collections)</td>
<td>• Does not retain tag lists; all collections become static on export</td>
</tr>
</tbody>
</table>
What property changes occur when I export a presentation to HTML format?

<table>
<thead>
<tr>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action bar</td>
<td>• Does not include the action bar at the top of a presentation</td>
</tr>
<tr>
<td>Artifacts</td>
<td>• Includes embedded artifacts and links to artifacts</td>
</tr>
<tr>
<td></td>
<td>• Embedded image artifacts retain their alt tags</td>
</tr>
<tr>
<td></td>
<td>• Embedded image and media artifacts retain their size settings</td>
</tr>
<tr>
<td></td>
<td>• Artifacts retain their type icon if displayed as a link inline</td>
</tr>
<tr>
<td></td>
<td>• Artifacts retain their titles and descriptions</td>
</tr>
<tr>
<td>Assessments</td>
<td>• Includes assessments made on items within the presentation</td>
</tr>
<tr>
<td></td>
<td>• Does not include assessments made on the presentation</td>
</tr>
<tr>
<td>Comments</td>
<td>Includes all comments for artifacts and reflections</td>
</tr>
<tr>
<td></td>
<td>• Does not include comments made on the presentation</td>
</tr>
<tr>
<td>Forms</td>
<td>• Does not include forms linked via a Quicklink</td>
</tr>
<tr>
<td>Learning Objectives</td>
<td>• Includes embedded learning objectives and links to learning objectives</td>
</tr>
<tr>
<td>Permissions</td>
<td>• Does not retain permissions; anyone can view content within an HTML presentation</td>
</tr>
<tr>
<td>Presentation layout</td>
<td>• Page links, navigation settings, page settings, page names, and text areas remain the same</td>
</tr>
<tr>
<td>Presentation theme</td>
<td>• Presentation themes retain their style settings, including custom replaced images</td>
</tr>
<tr>
<td>Profile details</td>
<td>• Profile information exports as displayed in the presentation, including customized profile titles and social media icons</td>
</tr>
<tr>
<td></td>
<td>• Only the fields set to display exports; hidden profile information does not export with the presentation</td>
</tr>
<tr>
<td>Quicklinks</td>
<td>• All Quicklinks retain their links to external URLs and artifacts stored within the export package</td>
</tr>
<tr>
<td></td>
<td>• Quicklinks to system resources require users to log in to the system and have the appropriate permissions</td>
</tr>
<tr>
<td>Property</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reflections</td>
<td>• Includes embedded reflections and links to reflections</td>
</tr>
<tr>
<td></td>
<td>• Does not include reflections associated with the presentation</td>
</tr>
<tr>
<td>Social media</td>
<td>• Does not include social media icons from the top of public presentations</td>
</tr>
<tr>
<td>Text areas</td>
<td>• Includes all text formatting, equations, and custom characters</td>
</tr>
</tbody>
</table>
About D2L

A global leader in EdTech, D2L is the creator of Brightspace, the world’s first integrated learning platform.

The company partners with thought-leading organizations to improve learning through data-driven technology that helps deliver a personalized experience to every learner, regardless of geography or ability. D2L’s open and extensible platform is used by more than 1,100 clients and almost 15 million individual learners in higher education, K–12, healthcare, government, and the enterprise sector—including Fortune 1000 companies.

The company has operations in the United States, Canada, Europe, Australia, Brazil, and Singapore.

Contact Us

Phone: 1.519.772.0325 (Worldwide)

Toll Free: 1.888.772.0325 (North America)
0.808.234.4235 (United Kingdom and Europe)
0.800.452.069 (New Zealand)
1.800.656.210 (Australia)
0.800.891.4507 (Brazil)

Fax: 1.519.772.0324

Email: info@brightspace.com

Twitter: @Brightspace


© 2015 D2L Corporation.
The D2L family of companies includes D2L Corporation, D2L Ltd, D2L Australia Pty Ltd, D2L Europe Ltd, D2L Asia Pte Ltd, and D2L Brasil Soluções de Tecnologia para Educação Ltda.
Brightspace, D2L, and other marks (“D2L marks”) are trademarks of D2L Corporation, registered in the U.S. and other countries. Please visit d2l.com/trademarks for a list of other D2L marks.
Google and the Google logo are registered trademarks of Google Inc.